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Preface

This Learner’s Book has been written in line with the revised ICT Syllabus. The knowledge
and skills which have been incorporated are what is partly required to produce a learner who
has the competences that are required in the 21st century.

This has been done by providing a range of activities which will be conducted both within
and outside the classroom setting. The learner is expected to be able to work as an
individual, in pairs and groups according to the nature of the activities.

The teacher as a facilitator will prepare what the learners are to learn and this Learner’s
Book is one of the materials to be used to support the teaching and learning process.
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Associate Professor Betty Ezati
Chairperson, NCDC Governing Council
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Chapter1
Introductionto ICT

N
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Key Words By the end of this chapter, you should be able to:

IKETE:
* a) explain what ICT is all about.

e hardware . $ : :
s ) identify common ICT tools and their uses in various fields.
e peripherals c) use various ICT tools.
d) appreciate the Safety precautions for the different ICT tools.
Introduction

In this chapter you will learn about the meaning of ICT and appreciate its various
applications in daily life. Just imagine the world without ICT! How would communication,
transfer of money, security, transport, learning amongothers in our lives be like?

Meaning of ICT
ICT stands for:
| - Information,
C - Communication
T - Technology

Hardly a day passes when ICT does not intrude into our lives. ICTs are used daily in one way
or another; people are connected through telephone networks, the Internet and the World
Wide Web. Refer to Figure 1.1.
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Figure 1.1: Common ICTs
Imagine Mr. Kaboyo making a telephone call to his mother, Mukade Jalia, to send her New
Year greetings. In this case, Mr. Kaboyo and his mother are communicating using technology
(mobile telephone) and information is the New Year greetings.
ICT can be compared with other systems. Let us compare ICT and a water system.

NOTE: ICT is electronic while a water system is mechanical

Imagine a water system comprising a water tank, water, taps, pipes and water moving
through the pipes. This can be related to ICT as follows.

Table 1.1: Comparison of a water system and an ICT system
Water system component | ICT

Taps, water tank, pipes Technology

Water Information

Water flowing through pipes | Communication

Activity 1.1: Meaning of ICT
1. Ingroups, look around your school or your community and identify at least 3 ICTs
familiar to you. State the function of each of the ICTs identified in the table below.
Table 1.2: ICT tools and their functions

ICT Tool Function

E.g. Camera Capturing photographs
1.

2.

3.

4,

2. Select any two ICTs from Figure 1.1 and identify the information they handle, the
nature of communication that takes place and the technology used.
3. With the available ICT tool, practice using it and identify the |, C,and T in it.

Common ICT Tools

At the beginning of this chapter, you learnt about the meaning of ICT. When we talk about
ICT tools, we are referring to devices or objects used in ICT. As people need and use
hammers, hoes, conveyor belts and pangas to produce, process and manufacture food, they
similarly use tools for data capture and processing, information storage and communication.
Therefore, ICT tools are not one solid thing but rather a collection of several electronic tools.

Figures 1.2 - 1.5 show some examples of basic ICT tools we interact with in our day-to-day
activities.
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Figure 1.2: Desktop computer set

Figure 1.4: Telephone handsets Figure 1.5: Radio

Activity 1.2: Common ICT tools

In groups, identify the ICT tool provided by name and characteristic(s). Summarise your
findings in Table 1.3.

Table 1.3: ICT Tools and their characteristics
Name of ICT tool/s Characteristics
Computer e Electronic tool

e Has hardware and software

e Can store information temporarily or
permanently

Activity 1.3: Identifying ICT tools with their specialized professional fields or areas
Identify and state some ICT tools and what they can be used for in specialized fields such as

communication, manufacturing, teaching and learning, health and medicine, security,
climate and weather, management.

Note: A computer is a major component of ICT.
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Use of ICTs ii society /Application of ICT
At the beginning of this chapter, you learnt that

Frelben o4 iiny wadie Medire dzuge cen
ICTs are used to collect and share information. In & i g . o
. = , iﬁ :

all situations, the ICT devices are used by people
or programmed by people to simplify work.

In our society today, use of ICT is on the increase
in all areas. ICTs are used to collect and
communicate information in our homes, schools,
hospitals, banking halls and many other places.
ICTs are also used in the entertainment industry,
security, agriculture and transport.

In the security sector, ICTs are used to monitor sensitive areas like banking halls and
airports, screening bags for unwanted materials and objects, and many others. However,
good ICTs may, in some cases, pose challenges.

Activity 1.4: Application of ICTs
a) Ingroups, identify the ICT devices used in each of the application areas shown in
Table 1.4 and what they are used for. Please note that each of the application areas
can have as many ICT devices as possible.

Table 1.4: Application of ICTs

Application area | Name of ICT Device What is it used for?

Home Mobile phone Sharing information in form of SMS,
pictures, emails, voice messages between
users

School

Entertainment

Security

Hospitals

Transport

Agriculture
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b) Give any advantages and disadvantages of using ICTs in our society. PROTOTYPE

ICTs in business

Most supermarkets, especially the big ones, have
adopted the use of Electronic Point of Sales (EPOS). If
you have bought an item from a shop and it is scanned
to determine the amount you need to pay, you have
used an EPOS. An Electronic Point of Sales (EPOS) is
self-contained, computerized equipment that performs
all tasks of a store checkout counter. It allows
payments by cash, bank or credit cards, verifies
transactions and generates a sales receipt. It also
coordinates inventory data. With this technology, the

Figure 2: Electronic Point of Sales (EPOS) shop owners are able to know the items that are
bought most, what is left in the stores and the items
that are running out.

Activity 1.5: Application of ICT in business
a) In groups, identify the ICT devices used in any business in your area and what they are
used for.
b) Discuss and make a presentation on the different ways in which a mobile phone can be
used as an ICT tool to support business activities.

Handling and Maintaining ICT Tools

Taking care of your ICT Tools is just as important as taking care of your books. The internal
and external parts of the computer and other ICTs have to be cared for. Taking care of ICT
tools is supposed to be done by all people who use them. However, as a learner you cannot
do all care and safety activities. Activities that require one to open up these tools are left to
people who have undergone specialized training on how to do it. As an ICT user, there are
certain tasks you can perform to ensure your ICT tools are clean.
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These include:

e Keep dust away: Dust your computer to keep it free of
dust and dirt.

e Keep food away: Do not eat or drink while working on
the computer.

e Use clean and dry hands: Make sure your hands are
clean before you type on the keyboard of click the mouse.

e Treat with respect: If you are having problems with your
computer, ask for help. Do not bang or hit the computer.

o Keep off: Seeing that when the computer is connected to
electricity, means that lightning could be conducted to
your computer through the electrical connection. For this
reason it is best not to use your computer during a storm.

e Stop virus attack: A computer virus is a program written
by a person on purpose to harm other peoples’ computers.
A computer virus is passed from one computer o another
when you share and download files without the protection
of antivirus software. For this reason you should get
permission before downloading files.

e Handle with care: The way you handle your CDs will
determine how long they will last. Always hold the CD
correctly as shown in the picture.

Some Computer laboratory safety and maintenance tools and their functions are
summarized in the Table 1.5.

Table 1.5: Maintenance tools and their functions

Maintenance tool Function
Dust blower Can be used regularly to blow dust out of a computer.
Air conditioner Regulates computer lab temperatures.

Activity 1.6: Handling and maintaining ICT tools
1. Otherthan a dust blower and an air conditioner identify any other ICT maintenance
tools in the computer laboratory and state their functions.
2. Identify a computer which needs cleaning and clean it up with the necessary tools.

3. Make areport of the steps followed in 2 above and tools used in the cleaning process.

ICT Safety Precautions

As ICT users, it is very important to take precautions when using ICT tools to avoid getting
health problems. We shall learn more about this in the chapter on Health and Safety. To
ensure that ICT tools are used with caution, manufacturers provide user manuals for all ICT
equipment.
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Activity 1.7: ICT safety precautions PROTOTYPE
1. Ingroups, discuss “rules that govern the use of the computer laboratory”.

2. Inyour opinion what are some of the threats of not protecting ICT tools.

ICT Tools security threats and measures

ICT tools like any other tools, need protection because they can be exposed to a number of
risks such as theft, virus, vandalism and others. However, care must be taken in terms of
handling, when they are in use and after use to protect them and make them less expensive
to maintain. Physical security, Electronic security and Document/files and network security
are very critical in addressing the measures of protecting and caring for ICT tools. Some
examples of these security measures include burglar proofing for physical security, use of
passwords for electronic security and use of firewalls for network security.

Activity 1.8: ICT tools security threats and measures

i) Take a walk around the school computer installations and identify some security and
safety concerns.

i) Assuming your school has just acquired new computers and these computers need
protection in order to be used for a long period of time. In groups, discuss security and
safety measures to safe guard these computers in line with Physical security, electronic
security and Document/files and network security.

User Manuals
The teacher will give you a sample user manual. In groups, study and discuss its features.

A user guide or user's guide, also commonly known as a manual, is a technical
communication document intended to give assistance to people using a particular system.

A User guide (Figure bbb) contains instructions on installing, using, or troubleshooting a
hardware or software product.
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PowerWatch - User Manual | Multi-slot card reader module | PoweredUSB LCD DISPLAY
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Figure bbb: Example of a user guide

Activity 1.9: ICT user manuals

Using a user manual from any new ICT device or one provided by the teacher:
a) identify the ICT for which the user manual is made.

b) summarize contents of the user manual in a) above including the safety precautions
therein.

Activity of Integration

ICTs are currently being employed in almost all fields in this modern era. Some of these
fields are Education, Banking and Security. In the area of education, it is possible for a
teacher in London to virtually conduct a lesson in a school in Uganda.

Tasks

a) Explain how the lesson above can be conducted by the teacher with ICTs.
b) Explain the precautions that should be exercised when using the ICT tools in (a) above.

Chapter Summary
In this chapter, you have learnt about:
e Themeaning of ICT
e Common ICTs at workplaces and their uses
e Application of ICTs in our daily lives
e Handling and maintaining of ICT tools
e ICT safety precautions and Security threats
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Chapter 2: Computer Hardware and System

Start up

portable system unit
media player {processor, memory, Web cam
{output device) (=5 and storage devices) {input device)

monitor
foutput device)

speakers
foutput device)
CD/OVD drive
(storage device)

(storage device)

mouse

L5310 finput device)

(input device)

microphone
{input device)

digital camera
(input device)

scanner
(input device)

card readerfwriter
(storage device)

2 ¢
USE flash drive
(storage device)

madem

external hard disk {communications device) ;

(storage device)
memory cards
Key Words By the end of this chapter you should be able to:
e hardware a) know the physical devices of a computer system and how each operates.
e device b) assemble a computer system.
e booting c) safely start and shut down a computer system.
e peripheral d) use computer peripheral tools.

Introduction

In this chapter you will learn about the physical parts of the computer and their use in everyday
life. Different parts of a computer are assembled to make a complete system. These parts may
be manufactured by the same company or different companies. Some of the hardware parts are
internal components (within the system case) while others are peripherals (externally connected
to the system case through a port). As a computer user, you should know how to assemble the
hardware parts and safely start the computer.

Meaning of Computer Hardware

Have you ever used a desktop computer? You realise that there is not any single part called a
computer. Generally, a computer is a system of many parts working together as shown in Figure
2.1,
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Speakers
Keyboard

Figure 2.1: Computer Hardware

The tangible parts that you can touch and feel, such as the monitor, keyboard, mouse, disk drives,
printer, scanner and speakers, are collectively referred to as hardware. The opposite of hardware
is software, which refers to the instructions or programs that tell the hardware what to do.
Software is intangible.

Note: In comparison with the human being, hardware may be considered as the body while
software is the brain.

Imagine you have been asked to type and produce a letter inviting your head teacher to a
debating competition in your class on Tuesday at 2:00pm in the main hall. In this case, you can
use a keyboard for typing, a mouse for controlling the cursor on the screen (these are input
devices), the printer will be used to produce a hard copy of the work seen on the screen (output).
Storage is done within the system unit where a hard disk is the one responsible for this activity.

Activity 2.1: Parts of a computer
1. Discuss and identify whether use of each of the devices labelled in Figure 2.1 is an input,
output, storage, communication or processing device and summarize your findings in the

table below:
Table 2.1: Parts of a desktop computer
Label Name of device Category
Mouse Input

AN (WIN|—

Categories of Computer Hardware

Hardware devices are categorized according to their functions. The various hardware categories
include input, output, storage, communication and processing devices.

Input devices are used for entering data or information into the computer after which other
processes can follow. Output hardware is used for producing or displaying information which
can be in form of a soft copy or hard copy. Storage devices are used for storing data or
information for future use. The storage devices can be inside the computer itself (internal) or
can be external to the computer. Sometimes storage devices can be looked at in terms of the
methods used to store data on them. For example, can you compare a flash disk and a CD? The
method of storing data on each of these devices is different.




ICT

PROTOTYPE

Activity 2.2: Categories of computer hardware

1. What is the difference between a soft copy and a hard copy? Give examples to
support you answer.

2. Move around the computer laboratory or any office in your school and identify other
computer hardware devices other than those mentioned in 1. above. Summarize their
details in terms of name, features, function and category.

3. Identify at least one device in each category and demonstrate how it works.

Assembling a Computer System

At the beginning of this chapter, you looked at hardware devices which can be
categorized as input devices like mouse, keyboard, microphone, camera; output devices
like monitor, printer, projector, speakers; storage devices like hard disks, flash disks
compact disks; processing devices like a CPU. Some of these devices are summarized in
Figure 2.2.

Figure 2.2: Some examples of computer hardware

When these devices are connected together, they make a computer system. For a
computer system to work well, the above hardware devices must be connected properly.
For instance, a keyboard, mouse, monitor should be connected to the System unit; the
system unit and monitor then connected to power either directly to the sockets or
through a UPS by use of power cables.

If you are setting up a newly purchased computer, you will probably find a how-to
guide or a user guide in the packaging that includes step-by-step details. However,
even if it does not include instructions, you can still set up the computer in just a few
easy steps.

Activity 2.3: Assembling a Computer System (Desktop)
1. With guidance from your teacher, assemble a computer system from its various parts
provided in the computer laboratory. You can make reference to the guidelines below.
Step 1: Check whether all the devices required ae available.
Step 2: Locate the monitor cable. It will usually be either a VGA or DVI cable. VGA
cables will often have blue connectors to make them easier to identify.

11
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Step 3: Connect one end of the cable to the monitor port on the back of the computer case
and the other end to the monitor. Hand-tighten the plastic-covered screws on the
monitor cable to secure it.

Step 4: Connect other devices by critically looking at the port types.

Step 5: Locate the power supply cables. Plug the first power supply cable into the back of
the computer case, and then into a surge protector. Then, using the other cable,
connect the monitor to the surge protector.

Step 6: Finally, plug the surge protector into a wall outlet. You may also need to turn the
surge protector on if it has a power switch.

Note: If you don't have a surge protector, you can plug the computer directly into the wall.
However, this is not recommended, as electrical surges can damage your computer.

2. Explain any key steps followed to assemble a computer system in 1. above.
3. What precautions must be taken while assembling a computer system?

Setting up a laptop computer

If you have a laptop, setup should be very easy. Just open it up and press the power button. If the
battery is not charged, you will need to plug in the AC adapter and charge it before using it.

If your laptop has any peripherals, such as external speakers, you may want to read the
instructions below, since laptops and desktops generally use the same types of connections.

Starting and Shutting down a Computer System

After assembling a computer (Figure 2.3), the next step is how it can be powered on correctly,
used and then shut down with proper procedures. The process of starting a computer is called
booting.

.

Figure 2.3: A Computer system ready for startup

Starting the computer:

Make sure all the plugs are well connected.

Switch on the electricity socket and the Uninterruptible Power Supply Unit.
Press the power button on the computer monitor first. It should show signal.
Press the power button on the system unit.

The computer should now start to boot and load windows.

If the welcome screen appears, select your username and enter the password.
The Desktop should now appear.

Give it time to load the elements and start up programs.
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Shutting down a Computer System PROTOTYPE

Turn off Computer option is located on the Start menu. The Turn off Computer dialog has the Turn
off the computer, Standby / Hibernate, and Restart Options.
Log Off and Switch User options are also located on the Start menu.

B

¥ crave

-

c
E Calculator

Sleep
Shut down

Restart

ZCanay Lrusn saga

l Chrome Apps

] .
I~ e |

Activity 2.4: Starting and shutting down a computer system
1. Explain the logical order of switching on the assembled computer system and
how it can be shut down properly.
2. Stating from a fully connected computer system, demonstrate how a computer
can be switched on and later switched off after use.
3. What precautions MUST be considered in 2. above.

Activity of Integration

Chapter Summary
In this chapter, you have learnt about:
a) the physical devices of a computer system and how each operates.
b) how to assemble a computer system.
c) safely starting and shutting down a computer system.
d) using computer peripheral tools.

13
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Chapter3
ICT File and Folder Management

.. Directorate Projects 2012

). Project A - opened Feb 2012
.. Project A - Communications

|, Project A - Financials
\, Project A - Planning

J. Logs
. Project Intiation Documentation

,. Work packages
|, Project A - Tasks and timelines
. Project B - opened Mar 2012

. Project C - opened Dec 2011
). Project K - closed Mar 2012

Key Words By the end of this chapter, you should be able to:
= a) use the different types of storage media to create, save and
e folder

transfer files.

b) convert data storage into various units.

Introduction

Hard disk drives have become very large in recent years and are capable of holding millions
of data files created by computer applications installed on the computer. As a result, a
method of organising these files is essential. Windows uses folders to achieve this.

File management is about arranging your work on a computer in a way that makes is easy to
use and accessible. While working with your computer programs, you create and save files,
such as letters, drawings, or budgets in an organized way. You use folders to group related
files, as with paper folders in a file cabinet.

In this chapter you will be able to use different types of storage media to store information
following the structure of files, folders and directories.
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Files can be stored in folders. Folders can be stored within other folders and these are
referred to as sub folders. Examples of the appearances of a file and a folder in windows
Operating System is shown below.

Partz SLDPRT
) SolidWorks Drawings Solidwiorks Part Document
: 47 KB

A Folder A File

Filenames are made up of two parts; document name and file extension.

The document name can be up to 256 characters long, including spaces while the file
extension is determined by the application being used.

Some examples of file extensions are shown in the table below.

Application File extension

Microsoft Word .doc [ .docx

Microsoft PowerPoint |.ppt/.pptx

Files and folders can be stored on various storage media such as Flash discs and Hard discs.
Activity 3.1: File extensions and storage media

1. Other than hard discs and flash discs, identify other three different storage media
within your school computer lab.
2. Compare any two storage media in terms of their advantages and disadvantages.
3. What are the file extensions of files created with:
- Microsoft Office Access
- Microsoft Office Publisher

15
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Organising Files

The management of computer files and paper files has much in common. If all the paper
documents accrued in a house or business were stored in a single drawer without using

paper folders, it would soon become impossible to find anything.

A well organised house will have some filing system to segregate electric bills from
telephone bills and from bank statements etc. Files on a computer should be managed in a

similar fashion.

A good practice is to use a Personal Folder to organise your files. This is the equivalent of a
filing cabinet in paper filing. It can be created in the My Documents folder or in the C: Drive
of the computer. This folder is the Root Folder of the filing system. Subfolders can then be
created for subject areas. Within these, further subfolders can be used to organise the files
within each subject. An example is shown below:

. Create a Root folder in My Documents

File Edit ‘iew Favaorites Tools  Help #
@ Back Q [ﬁ p Search E:_H Folders v
Address |B My Documents EI d =

2 &

[y Music My Pictures

File and Folder Tasks &

£ Make & new Folder

File Edit “iew Favorites Tools  Help #
e Back - Q L} p Search H':: Folders v
Address |E| CiiDocuments and SettingsiAdministratori My Documentst John B] Go
Bl -
File and Folder Tasks & 1 lﬁ D Ej
E’—j [Aake s v Faldet 3 Adrnin Engineering Tech Drawing  Technology
E R B O B B A | .
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File Edit ‘“iew Favorites Tools  Help #
Back - 5 - | Search _l-‘; Folders -
@i~ © 3 P 2
Address |Ei| Ci\Dacurnents and Settingstadministratoriiy Documents) JohrmEngineeting G0
File and Folder Tasks & Ej Ej B Ej
E’ Make & new Folder Class Motes Drawings Tests Resources
Fublish this folder to
ﬁ the Weh
. Continue the process until the required level of organisation achieved.

File Edit ‘iew Favorites Tools  Help #

°Back - @ & pSearch BE: Folders v

Address |E2| CiDocurments and Settings! AdministratoriMy Document sy John\EngineeringlClass l G

1 B B B

Lsk Year 2nd Year 3rd Vear Transition
Year

File and Folder Tasks &

Eﬁ‘ MMake a new Folder
&) Publish this folder to

the Web i
et Share this Folder Ej Ej

—] Sth Year Bth Vear

|

This organisation will make files easier to find and backing up your files will involve copying

the root folder to the backup device.

Activity 3.2: Creating folders

Folders can be created by a number of methods:

Method 1:
1. Browse to where you want to create the folder.
2. Click the File menu, choose New and then Folder.

| #

Edit  View Faworites Tools  Help

CMew  » [oEod

Create Shorkout |E| Shortcut
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3. Thefolderis created.
4. Type aname for the folder and press Return or click away from the folder to

complete.
s
Fle Edit ‘iew Favortes Tools  Help a
Dot © (B Oseach [ roters [T
Address | (23 My Documents - | v| B o

File and Folder Tasks 2

2 @& b

Ty Music My Pictures

\Eil Rename this folder

Method 2:

1. Browse to where you want to create the folder.

2. Right-click within the window, choose New and then Folder.

M

File Edit ‘iew Favorites Tools  Help &
@ Back - @ @ | /O Search &:_3 Folders v
address |E2| C\Documents and Settingst Administratority Documentst John E] Go
| ks View »
File and Folder Tasks % |
Arrange Icons By b
Eﬁ Make a new Folder Refresh
a Publish this Folder ko ) )
the Weh Customize This Folder. ..
=t Share this Falder Pacts

Paste Shortout
Undo Rename Ctr+-2

B

| Other Places

h (£ My Documents

(%) Shared Documents w Properties

@ Shortcue

3. Complete as for method 1.

Method 3:
Afolder can be created while saving a file in a computer application.

1. InWord 2007, click the Office button and choose Save As and Word Document

e

D Mew Save a copy of the document
X il Word Document —— -
o | Save the document in the default file
~ 7 Dpen format,
Word Template

Save the document as a template that can
be used to format future documents,

—] Word 97-2003 Document
ﬂ Save As | L = | Save a copy of the document that is fully

compatible with Ward 97-2003.

Sawve
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2. Browse to the required folder and click the Create New Folder button. PROTOTYPE
Save ks i2%]
Save in: |I4_j Adrmiristration M G If o
Lé ‘E Schemes ‘

3. Name the folder and Double-click it to open it. Save the file in the new folder.
Managing Files and Folders

Files and folders can be Selected, Copied, Pasted, Moved, Renamed and Deleted.
Activity 3.3: Selecting Files

1. Open adrive or go to desktop where there are files and folders.
2. Toselect a single file, just click it. It changes colour on selection.

. D.C.G Sketching material

File Edit Wiew Favorites  Tools  Help

aﬁack - @3 " ﬂl_l; pSaarch i.:_u Folders

Address || || Z:\D.C.G Sketching materialD.iC.G Sketching mate

@ Write these files to D

Files Currently on the CD

Alarm Blackboard  childs lego.doc
clocks, doc Duster.doc

3. Toselect consecutive files, click the first file, hold down the Shift key and select the

last file. The files in between are automatically selected.

'! D.C.G Sketching material

File  Edit  View Favorites Tools  Help

eBack - @ . ‘.i_li pSearch HLJFDIders @- @ Folder Sync

Address || ) Z:\D.C.G Sketching materiallD .. G Sketching material

Cornpack
Discs,doc
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4. To select non-consecutive files, hold down the Alt key and select the files in turn.

‘ D.C.G Sketching material

File Edit Wiew Favarites Tools  Help

eBack e @ ' U pSearch ijl_uFoIders [@' @

Address | Z:D.C.G Sketching materiahD. .G Sketching material

Y

& Writethesefilesto CD

Files Currently on the CD

Alarm
clocks, doc

5. Toselect all the files in a folder, click the E

: toy
it command and choose Select All.

‘ D.C.G Sketching material

File F View  Favorites  Tools  Help
Undo Chrl+2 | S—
e garch '/ Faolders .v |E?;
Cuk Chrl+x i
Addre  Copy Chri+C WD, & Sketching material

Paste ZEA+Y
Paste Shortout

File{  Copy To Folder,.,
Move To Folder. ..

Select Al Chrl+-A

Invert Selection
Bottles.doc clocks.doc

Note: The above procedures apply equally to groups of folders.

Activity 3.4: Copying and pasting files

1. First select the required file/s.
2. Thenright-click the files and choose Copy.

I e 1
Open
Edit

[ [=
Prink

Alarmn
clocks,doc

= E = Corvvert to Adobe POF =

Hairdryer.doc  Lighter.doc  Lunch Sean with AYG ils
Open With N S

E:__‘ % Send To =
Rendering Rendering Shs  Cut hing
objects ...  objects wor... .doc
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Note: The files are copied to an area of the memory called Clipboard.

3. Browse to the destination folder, right-click it and choose Paste.

(=

File  Edit  View Favorites Tools  Help

0 Back - 0 @ Ip Search l-E: Folders ‘ -

Address |E{| CDocuments and Settingst AdministratoriMy Documents!Johni Tec

File and Folder Tasks % ]
Open

IEII Fename this folder Explare
[ Move this Folder Search...
[y Copy this folder

e Publish this folder ko
the Web Send To ’

| Share this Folder
@ E-rnail this folder's files
¥ Delete this Folder

Sharing and Security, ..

Cuk

Moving Files without Leaving a Copy

The procedure is similar to copy and paste except that instead of choosing Copy, you choose
Cut.

E.

Alarm OF"B“ iter
clocks.daoc Edit .doc
oo =, Mew
&) &)
Haitdeyer.doc  Lighter.doc  Lunch bocedoc Memary = Corvert to Adobe POF v anid
sticks.doc ; ad. ..
Scan with AYG
v L _; % % Open With 3 %
S - - - Send To »
Rendering Rendeting Shading Shadows.doc ing
objects ...  objectswor,.. curvedsu... 5.doc
copy
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Renaming Files

Files must be renamed individually. To rename a file, right-click it and choose Rename. Type
the new name and press Return or click away from the file.

% Cpen With 3 % @
| SendTo k = ——

After filds leqo.doc  childs koy.doc Compact
Bothle  ©Cuk Discs,doc
Copy et
= Create Sharkcut = E—E:
Hairdrd  Delete Moy Mabile MP3
Rename sticks. doc phone, doc player.doc

PrnpertiesLEl - % % %

Rendering Shading Shadows.doc sketching sketching
objects war,,,  curved su... cones.doc cubes,.doc

Deleting Files

Select the files to be deleted. Right-click any selected file and choose delete from the menu.
Click the Yes button in the dialog box.

Copy

Create Shorbouk
Hairdryer.doc  Lighter.doc  Lunch box

Rendering
objects war..,

Rename

Properties
—

Shadows . doc

The Recycle Bin
Files and folders deleted from the computer are placed in the recycle bin. They are not lost
until the recycle bin is emptied.

Activity 3.5: Managing the Recycle Bin
1. Delete a folder normally by right-clicking the folder and selecting Delete.

cut —
Copy
File  Edit ‘iew Favorites Tools Help Paste

OBack o £ L% :pSEarch H

Address |B My Documents

. | Properties
File and Folder Tasks & = L,J = L,"}

IEE Renarne this Folder ™ [ahn My Music My Pictures

Create Shorbout

Rename
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2. Check in the Recycle Bin to confirm if the folder/file has arrived.

-

Recycle Bin

3. To Undelete the folder, right-click the recycle bin and choose Open.

| il
- Open |
Explor
Empty Recycle Bin

Create Shortout

Properties

4. From the Edit menu, choose Undo Delete to restore the folder to its original location as it
gets out of the recycle bin.

Cut Chrl%
g Copy Chrl4+C
Paste Chrl+y

Paste Shortcut ~— || John
936 KB

& Copy ToFolder...
Move Ta Folder.

Measurement of Storage Capacity

In a computer system, data is represented using the binary system; combinations of binary
digits (bits). There are only two binary digits, 1 and 0. These digits can be arranged in such a
way that they represent characters, digits and other values.

Data storage has various units including bits (b), Bytes (B), Kilobytes (KB), Megabytes (MB),

Gigabytes (GB), and Terabytes (TB).

Activity 3.6: Data storage units

1. Distinguish between a bit and a byte.
2. What s the relationship between bits, bytes, kilobytes, megabytes, gigabytes and
terabytes? Give examples where necessary.

Activity of Integration

1. Avresearcher saved her draft work on a CD ROM from a friend’s computer with an
intention of sending it to her supervisor by e-mail once she got home. However, on
reaching home, she realized that her computer could not read a CD ROM.
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Task: How can you advise this researcher to have her work sent to the supervisor without
physically going back to her friend?

2. Astudent borrowed a computer with a hard disk of 40GB on which he saved his project
work for 3 years. The project work on the hard disk is stored on a space of 30GB.
Recently, the owner of the computer requested to have it back and provided the student
with a pack of 100 CDs each with a storage capacity of 700MB on which project data can
be transferred.

Task
a) Describe how the project data could be transferred from the hard disk onto the CDs
provided by the student.
b) How many CDs full of data do you think the student used? Give reasons for you answer.

Chapter Summary

In this chapter, you have learnt about:
e creating, saving and transferring files across various media.
e converting data storage into various units.
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Chapter 4
Word Processing |

= .::::_:-:m YL i
'Wnrd Fruu.es;.mg Shll.lﬁ
: T Tt o O

B By the end of this chapter you should be able to:
e word processing a) understand the word process or interface.
e Jayout

b) use aword processing software to create, format, edit and print a

e mail merge document.

Introduction

Word processing is a very important skill for you if you are aiming at becoming
computer literate. Once you have learnt how to word process, you will be in position
to use word processing software (e.g. MS Word) appropriately to create, edit and
print documents.

There are specialized programs which you can use to word process. Such programs
are called word processors. A word processor has numerous features whose uses
you need to understand if you are to use it appropriately.

Microsoft Office Word is one of the most commonly used word processing software.
Different versions of Microsoft Office Word include MS Word 2007, 2010, 2013 and
2016. In this book we are going to demonstrate using Microsoft Office Word 2007
Platform.
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Features of a Word Processor

Ribbon Tabs

The image on the right shows a

window of a word processor

with some features that enable

a user to manipulate a

Basic Layout of a Word Processor
(Microsfot Word)

document.

Figure 4.1: MS Word processor window

Activity 4.1: Understanding the features of a word processor
In groups:
1. open aword processor.
identify the groups of the word processing features.
type the sentence “I love my school”.
select (highlight) the sentence in 3 above and click on any three features.
observe the changes which occur in the text.
state the function of each of the features identified.

ok W

Copy and complete the table shown below about the features of a word processor

Feature Identified Group it belongs to Use of the feature in word

processing

7. Shareyour findings on the word processing features and the group they belong to.

Hint: To open a Word Processor, go to Start »All Programs > MS Office > Word Processing program

Customizing Word Processing Working Environment

Before you begin creating documents, ensure that you have set up your Word

environment and become familiar with a few key tasks such as minimizing and maximizing
the ribbon, configuring the Quick Access toolbar, using the ruler, word counting and zooming
tools.
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Activity 4.2: Setting a word processing environment

Customizing the Quick Access Toolbar

. . ‘Customize Quick Access Toolbar ]
1. Click the arrow to the right of the — " E
. [ onen A
QUICk Access tOOIbar' Baste EnddtuQuickAccessTouil}al] ]E
+ - Format Paint
2. Select the command you want to add Clipboard E-mail N
. . Quick Print .
from the drop-down list. It will appear e |
Print Preview
in the Quick Access toolbar. Spelling & Grammar
| Undo
i Redo
Draw Table
Minimising and Maximising the Ribbon More Commands...
Show Below the Ribbon
Minimize the Ribbon
—— Cove
3. Right-click anywhere in the main menu. Home
.. . . Customize Quick Access Toolbar...

4. Select Minimize the Ribbon in the | [ﬁ % E Show Quick Access Toolbar Below the Ribbon
menu that appears. This will toggle the | =" ,f?,mm Ribbon |
Ribbon on and off. - 7 ' ‘

|Clipboard Font |

Customising the task bar : Customize Status s

= Formatted Page Number 1

5. Right-click anywhere on the task bar. v o o

6. Select the items you would like to appearon |- P :

. i Column 1
your task bar as you work from the popup . (] wora court o
menu. 2 — |

. et s ol -

; — o

: g:w:: insert|

g Selection Mode

s

|;am—. Tof1  Column: 1 | Words:0 | | ;Mm Aler —
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Saving an MS Word Document File

Saving is the process of storing a document in a certain location or creating a file. This can be
done on a newly created document or on an already existing document. Saving is normally in
two categories; Save and Save As.

When saving for the very first time, Save and Save As behave the same way. They both prompt
for file name and location.

Click on the Office button>Save As>Type File Name>Choose Location>Save
Otherwise, Save and Save As behave differently on an existing document.

Save
This is a command used when saving changes made on an existing document without changing
the file name and location.

Save As

This is a command used when making a copy of the file in a different folder or making a copy
with a different name.

Click on the Office button>Save As>Type File Name>Choose Location>Save

Activity 4.3: Saving a file
Saving a document with file name NCDC in My Documents location:
1. Open MS Word program.
2. Select Office Button > Save or Save As.
3. Select Desktop as the location to save in.
4. Give the file aname, NCDC.

Tip: Save your file immediately after creating it to prevent the possibility of losing it later due to
power failure.

Activity 4.4: Working with text
1. Typesome textin your text area of about four paragraphs to help you practise word
processing skills. Press Enter key on your keyboard to get to the next line.

Selecting text
2. Move your insertion point next to the text you want to select.

3. Left-click and while holding down, drag the mouse over the text you want to select.
4. Release the mouse button. You will have selected the text. A highlighted box will appear
over the selected text.

Inserting text anywhere in your text

5. Move your mouse to the location where you want text to appear in the document.
6. Left-click the mouse. The insertion point appears.

7. Type the text you want to appear.
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Deleting text
8. Place your cursor next to the text you want to delete.

9. Pressthe Backspace key on your keyboard to delete text to the left of the cursor.
10. Press the Delete key on your keyboard to delete text to the right of the cursor.

Copying and Pasting Text ()2 ~4a)-

11. Select the text you want to copy.

| Ho?‘l Insert Page Layout

12. Click the Copy command on the Home tab.

Copy (Ctrl+C)

13. Place the cursor where you want text to

Copy the selection and put it on
the Clipboard.

appear.

14. Click the Paste command on the Home tab.

Tip: Highlight text before applying any formatting on it.

Activity 4.5: Practising text formatting

Your class is planning an end of year party at the end of the term scheduled to take place in the
main hall on 215 November this year starting at 8:30am. Word process a letter inviting the head
teacher and members of staff to the end of year party.

Page Layout

All along you have been using the default settings of your word processor. You are now going to
learn how to change these settings to suite your document requirements. In the next set of
activities you will learn how to change the margins, document orientation, use columns in your
document as well as adjust the line spacing of text.

Activity 4.6: Changing page orientation

Open a page with text on it.

1. Select the Page Layout tab. o9 ©BAa s
T T e

2. Click the Orientation command Home  Insert | Pagelayout | Reference

in the Page Setup group. @ - @ L2 Orientation -} = Breaks -

) . . | Tl.'i """ | - . ine Mumbe

3. Left-click either Portrait or | emes 5] I argins Q Portrait —

Landscape to change the page | Themes =

orientation. = ancscape m—
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Activity 4.7: Setting the margins
The margins of the document determine the amount of text area

for your document. To change your margins: insert | Pagetayout | Reterences _ maile
1. Select the Page Layout tab. l T I EE
largin;| Orientation Size Columns
. . . = - - -~ bE Hyph
2. Click the Margins command. A menu of options L= wom
Top: 14 Bona!n: 1
appears. Normal is selected by default. L E=" | R
''''' Narrow
3. Left-click the predefined margin size you want. lh 0F  mone o3
‘___ Moderate
Top: 2 Bottom: 1
Left: 0.75" Right: 075"
Wide
Top: i i Bottom: 1°
Left: z Right: 2~
_ Mirrored

Top: 15 Bottom: 1
Inside: 1.25° Qutside: 1"

Top: 1 Bottom: 1*
| || et 125 Right 125

Custom Margins...

Page Selup

You can also change the page margins by clicking on the

vl z ol - custom margins from the menu. The page set up dialogue
ape 7 ¢ e et M| box appears from which you use the arrows or directly type in

the desired margin sizes.

Bortrat  Landgeape
Pages
Mukiple pages: Normal vJ

=

Appy to: lw‘h:iadwmt v:

T
USing Columns Page layout | References Mailings R

= Breaks ~
£=] Line Numbers
b~ Hyphenation ~

One I

Most newspapers, magazines, academic journals, —
newsletters’ texts are laid out in columns. In the default lj
15 Orientation Size

settings your word processor has one column. 3 3
Page 55 :

Activity 4.8: Using columns in text
You can change the number of columns by following
these steps:

1. Create a paragraph of text or Copy and paste _ Three
some text onto your page. _
Select the text you want to format. |E=]| |Left
Select the Page Layout tab.

Left-click the Columns command. ;‘ S

BE More Columns...




ICT
PROTOTYPE

5. Select the number of columns you want to insert.

Note: More columns can be got by selecting the more Columns menu.

Navigating through a Document

Navigation means moving around a document. This can be done using arrow keys shown below
or Keyboard shortcuts.

Activity 4.9: Using arrow keys
1. Open aword document with text.
2. Pressthe arrow keys on your keyboard and observe how the cursor moves around the
screen. You can also click your mouse within the document to place the insertion point
where you want to type next.

Locating Specific text in a word document

When a document comprises many pages, locating a specific text might be cumbersome. Word
processors have a mechanism of locating specific texts.

Activity 4.10: Locating specific text
1. Load afile with text on at least two pages.
2. Click the Home ribbon’s Find button to display the Find and Replace dialog box OR
Press Ctrl+F to display the Find and Replace dialog box.
Enter Search Text
Type the text you want to find in the Search for text box.
Start the Search
Click the Find Next button.

o vk w

Note: Word searches from the current text cursor’s position in the document to the end of the
file. If Word finds the text, it highlights it.

Activity 4.11: Replacing Text
1. Select the text you want to replace.
2. Click the Home ribbon’s Replace button instead of the Find button to display the Find
and Replace dialog box. OR Press Ctrl+H to display the Find and Replace dialog box.
3. Typethe new text into the “Replace with” text box.
4. Replacethe Text.
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5. Click the Replace button to replace the next occurrence of the found text with your
replacement text.

Grammar and spell check

When you are typing, sometimes a wavy red or green line appears beneath your text. Red and
Green wavy lines indicate spelling and grammatical errors respectively. Missing space after a
comma or a period, or doubling of a word (the the), is also detected as a mistake. Below is an

example of a spell checker in action.

When you are tyiping, sametimes a waby red or green line appears beneath your text. Red and
Green wauﬁ lines indicate splling and grammatical erors respectively. Note that a word
processor also regards a missing space after a comma

Activity 4.12: Text proofreading
1. Openanew document.
2. Mistype a word so that the wavy red line appears. For instance tyiping.
3. Rightclick on the underlined word. A context-sensitive menu will open up.

ippears. For instance Iyiping

text-sensitive menu will open typing

Ignore All
Add to Dicticnary

ved word will automatically b &, Hyperlink...

M . t
rhecl wheather mavhe won 1ad L Ew ommen

4. Click on the correct suggestion, the mistyped word will automatically be replaced.

In case Word does not make any suggestions, then check whether maybe you left out a space
after a period or comma. Please note that there are many proper nouns and specialist terms
that Word does not recognize.

\Tip: A wavy red line does not always mean that you have made a mistake!\

Character formatting

Formatting is the art of making your documents effective and attractive. Good formatting
distinguishes different parts of your text and helps your readers take in your message. Word
processors provide a wide range of tools that can help you create professional looking
documents. Characteristics that affect the appearance of one or more characters are called
character formats. You can apply formatting to just about every element of your document,
from a single character to entire paragraphs. The formatting ribbon below contains functions
which can format characters, sections, and paragraphs.
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190425-Extract ICT doc [Compatibility Mode] - Word
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW

X P .

Eg Copy
- o oo ake o
~ Format Painter BT U -abex ) A - A

AaBbCcl AaBbCDe AaBbCcD: AaBbCcD AaBb( AaBbCi AaBbCc Al
Heading6 = TMNormal | NoSpacing TTablePa.. Headingl Heading2 Heading3 H|

Clipboard [ Font [F] Paragraph F] Styles

(0 =

Changing the font

Use the Font dialog box (Alt+H, FN) to format characters. Letters, numbers, and punctuation
marks are all printable characters and, as such, you can format them. Once you select a
character or a group of characters, you can apply any of the formatting commands on the Home
tab’s Font group (Alt+H). You can choose a font and a size for any character in your document.

You can make characters bold, underlined, superscript, or change them to just about any colour
of the rainbow.

Activity 4.13: Character formatting

1. Select the text you want to format.
2. Find the Font field on the Home ribbon.

2 Font Size
Home | | |
X | =

- Times Mew Roman > |12

3. Click the drop-down arrow next to the Font field.
4. Alist with countless font choices appears as shown below.

HOME INSERT DESIGN PAGE LAYOUT REFERENCES

O meeR |5 X s

| Copy

. Theme Fonts =
Format Painter T
U

Calibri Light (Headings
iboard

o = . Calibri (Body,

Recently Used Fonts b

i

O Times New Roman Fi

O Tahoma

O Avial Marrow

O Century Gothic

O Lucida Console

O Century Schoolbook

All Fonts

O lgency B

O Aharoni nn TN
O ALGERIAN

0 Andalue 2wyl

[o]

5. Select the font you want by clicking its name. You can also change the font
size to your preference.

B =
First select the relevant text. : %
7. Find the Font Size field on the Home ribbon, and click the drop-down arrow |10 |
next to it. H
12
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8. Onthe list, find the font size that suits you and click it.

You can also format your text to be bold, italic or underlined.

Tip: You can also specify your own font size by clicking in the Font Size field and typing in the
size that you want and then press ENTER.

(\ctivity 4.14: Bolding, italicizing and underlining

1. Select the relevant portion of your text.
2. Click the appropriate character formatting button on the Home ribbon.

‘B _Bold

A _talic

U _underline

3. The drop down arrow next to the underline button offers you a choice of underlining
styles.
4. Toturn a character format off, select the text and click the same button again.

Alignment of Text

By default, paragraphs are usually left-aligned: the left margin is straight, but the right
margin is jagged. Word provides you with a number of other options though. Just

position your cursor anywhere in the paragraph, and

click on one of the text alignment buttons on the Home ribbon.

= Align left: text is aligned at the left margin but jagged on the right.

= Centre: text is centred within each line, with jagged margins on both left and

right.

__Align right: Text is aligned at the right margin but jagged on the left.

=1 Justify: text is aligned at both the left and right margins (Word does this by
adjusting the amount of space between words).

How to Create a Bulleted and Number List
Using bullets
+ First, type the points that you want to bullet, one under another. Make sure you
create them as individual paragraphs by pressing [ENTER] after typing each
point.
+ Select the paragraphs that you would like to bullet.
Click the Bullets button in the Paragraph section of the Home ribbon. |i
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Tip: The drop-down arrow on the right of the Bullets button allows you to choose
from ditferent bullet styles.

Creating a Numbered List

a—
F— T
F—

Instead of clicking the Bullets button, click the Numbering button just next to it.
The best thing about Word numbering is that the numbers adjust themselves
automatically when you edit the text.

| Tip: To end a bulleted or numbered list, just press [ENTER] twice.

Changing the Bullet/Number Style
Go to the drop down list bullet or number (figure below) and select an option.

Note: Adding a Numbered List follows similar steps

Paragraph ]

Adjusting Line spacing

When words are close together or sentences are compact, they can be difficult to read
for some people. Depending on the font type used, it may not look nice to read.
Therefore, word processors have line spacing provision ;"tg«“lg - B | I s noemat |ﬂ Mol

to allow space adjustments between the lines. El 10 N
Activity 4.15: Working with line spacing : 1:5
1. Select the text you want to format. 'w 20
2. Click the Line spacing command in the 8
Paragraph group on the Home tab. z:* Spacing Options..
3. Select a spacing option. = Add Space Before Paragraph
= pemove Space After Paragraph
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If you select Line Spacing Options, the Paragraph dialog box appears.

Paragraph |E”X|
4. Usethe Line spacing drop-down menuto | e
. . Alignment: _
select a spacing option. oot el
5. Modify the before and after points to Inertaien
X X X Left: Special: By
adjust line spacing as needed. w7 5] Jew N[ B
. [ Mirror indents
6. Click OK. .
Before: Line spacing: A
After: [tope F] |pouble ~| 3
[[] bon't add space between paragraphs of the same skyle
Previe o
Working with Objects
In the previous activities, you have been working e
with text only. In this section, you will add (= ) (o] [ [ =]

information to your text in form of objects. You
will learn how to add images/pictures, tables, charts smart arts, screenshots and
illustrations.

Making use of Clip Art Objects

You might be asking yourself “what is clip art?” Clip art is a collection of pictures or
images that can be imported into a document or another program. They are already
part of your word processing software.

Activity 4.16: Working with Clip Art l! a)* Flyer [
1. Selectthe Insert tab. | Insert l Fage Layout References Mailings
2. Click the Clip Art command in E ElE] @ ‘ ﬁ Y
the Illustrati Iﬂﬁ' KL] =] A E
€ [tlustrations group. | Table || Picture| Clip [Shapes SmartArt Chart || o
3. TheClip Art options appear in the task ‘ ) Q‘m - ‘ o
. Tables INustrations
pane on the right.
) ] Clip Art
4. Enter keywords in the Search for field that _ _
. Insert Clip Art into the document,
are related to the image you want to including drawings, movies,
. sounds, or stock photography to
Insert. illustrate a specific concept.

5. Click the drop-down arrow next to
the Searchin field.

6. Select Everywhere to ensure Word searches your computer and its online
resources for an image that meets your criteria.

7. Click the drop-down arrow in the Results should be field.

8. Deselect any media types you do not want to see. In this case we only wanted
Clip Arts.




ICT

PROTOTYPE
9. Click Go to see a list of images depending on [Cipat x|
your search. Search for:
10. Try to insert other object types (tables, pictures, [phnne |
charts, header/footer). Search in;

| Al collections

Reszults should be:

) ' ] Selected media file types
Most times, images inserted may need some EBE] Al media types
adjustments to fit properly into spaces where they are - Clip Art

inserted. This can be done in various ways including @01 Photographs
F-C Movies

&~ Sounds

Formatting Images/Pictures

cropping and compressing the images. When you crop
an image, part of it is removed. Cropping may be helpful
when a picture has a lot of content and you want to focus on only part of it.

Activity 4.17: Cropping images

1. Select the image you want to crop. The Format tab appears.

T REFEREMCES MAILINGS REVIEW VIEW

" = : 2 o o Align~
,/ == Dashes ~ a = Iz VR (1
;E) = — '—-I I:l =k TEI Group B |:|
Picture EWeight' Position Wrap Bring Send Selection . r Jw
Border - = Text~ Forward = Backward= Pane - Rotate~
Border M Arrange £

g i 1 i 3 i 3 i 4 i 5

2. Onthe Format tab, click the Crop command.

3. Cropping handles will appear around the image. Click, hold, and drag
a handle to crop the image.

4. Click the Crop command to deselect the crop tool.

Note: The mouse pointer appearance may vary from MS Word version to version.

Compressing Images

If you use large pictures in a document, its file size increases rapidly. As a result it may be
difficult to share such a file via the Internet. You can reduce this problem by telling a word
processor to compress the pictures inserted in a document.

Activity 4.18: Compressing images
1. Select the picture.

2. Select the Format tab.
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Click the Compress Pictures command in the Adjust group; a dialog box
appears.

Click the Options button to access the Compression Setting dialog box.
Choose the target output.

Change any of the default picture settings you want.

Click OK in the Compression Settings dialog box.

Click OK in the Compress Pictures dialog box.

Activity 4.19: Comparison of compressing and cropping

In groups, distinguish between cropping and compression in relation to images in a
document.

Working with Tables in a Document

Atable is made up of rows and columns. Tables are mainly used to organize and present
information. You can also use tables to align numbers and create interesting page layouts.

Activity 4.20: Inserting a table

1. Click where you wantto insertthe table.

2. Click the Insert tab and clickon the [Table] button-atable grid and other options
appear:
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ba] BB (@ 3
Picture (ii: Shavpes Sm

[ [ [ [ [
I O

{0

3 InsertTable..,
74 DrawTable

sis | Convert Text to Table

ﬁ] Excel Spreadsheet
] Quick Tables »

3. Create a3 x3Table.Drag the mouse cursor over the cells and clickthe mouse button
when the table is of the desired size (ifyou hold down the mouse button, the table is
drawn when you release it).

Tip: You do not have to set up the number of rows required when you first create a
table as Word will automatically add extra rows for you as you type.

4. Tomove outofthe table, press <Ctrl End> or use the <down arrow> key several times
-the Table Tools tabs disappear, showing thatyou are no longer in the table.

5. Press <Enter> for a blank line.

Inserting a Table by Setting the Number of Rows and Columns

1. Position the Insertion Point where the table isrequired.
2. Clickon the [Table] button (on the Inserttab) and choose Insert Table... command.

3. Thelnsert Table dialog box appears -under Table size, enter the Number of columns: and
Number of rows: required (here, setup 4 columns and 2 rows).
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Insert Table

Table size

Mumber of columns:

P |
LR

Mumber af rows:
AutoFit behavior
(%) Fized column width: | Auto

L

() AukoFit to conkents
) AutoFit to window

[] remember dimensions for new tables

L oK ][ Cancel ]

The next set of options down, Autofit behaviour, determine how the column widths are
defined. By default, column widths are setso that thetable fillsthe page horizontally with
equally-sized columns (as you saw with thefirst table). If you require specific widths (of an
equal size) change Fixed column width: from Auto to the desired size.

4. Here, change Autofit behaviour to AutoFit to contents.

5. Press <Enter> or [OK] and a verysmall skeleton table appears.

Activity of Integration: Word Processing a Letter

Your class is planning an end of year party at the end of the term scheduled to take place in the
main hall on 21% November this year starting at 8:30am.

Task: Word process a letter inviting the head teacher and members of staff to the end of year party.

Chapter Summary
In this chapter, you have learnt about:
e how to load word processing application software.
e formataWord document (page orientation, margins, size, fonts, paragraphing, etc.).
e insert objectsin a Word document (tables, images, shapes, header and footer).
e print documents.
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